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Oracle Hyperion

Market Leader in Enterprise Planning, Budgeting & Forecasting
Source — Gartner

Over 8000 customers

Product is mature, scalable and innovative



Hyperion Overview

Hyperion is an Oracle based product that delivers

O Aweb & excel based planning, budgeting and forecasting solution

0 Consolidation and financial close management solution [known as HFM]

O Financial Reporting Studio

O Financial Data Quality Management & MDM [known as DRM]

U Crystal Ball that allows predictive modelling, time series capabilities, monte carlo
simulations

Some additional information

O Hyperion has a Japan Statutory starter kit for HFM providing Japanese
GAAP and IFRS capabilities

0 Hyperion has an ERP Integrator that allows interface with Oracle

General Ledger Release 12, facilitating transfer & drilldown of GL actuals & Hyperion

budgets

0 Smart view excel technology used in Hyperion is also available in Oracle Fusion
Apps

O Hyperion integrates with Oracle's Governance Risk Compliance tool, as does Oracle
Fusion Applications.

O Hyperion has a Calculation Manager component that allows creation of business
rules using graphical user interface



Hyperion Financial Reporting

Hyperion Financial Reporting

O Can contain embedded charts & be used for dashboard type presentation in
browser

O Expect this to be used for main Statutory & Regulatory reporting statements

O Expect this to be used for the core operating financial statements (P&L, BS, Cash
Flow etc)

O Expect this to be used for core variance reports to budget & latest forecast

O Expect this to be used for high volume and repeatable reports, Analysis of key
accounts by custom dimensions

O Centrally managed and controlled, no user amendments (client), therefore ‘one
version of the truth

U Financial reports can be ‘pointed’ at the Essbase data — as used at Barclays,
HSBC, RBS, AIB etc



Hyperion Financial Reporting Studio
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Hyperion Smart view — Infegration to Excel

Hyperion Smart view
O MS Office reporting capability (primarily Excel but also Word & Powerpoint)

O Expect this to be used for ad-hoc analysis of key accounts by custom &
supplementary data review

O Expect this to be used for some of the control reporting and slice and dice
analysis

O Retrieve and export data to/from Microsoft Excel

O Dynamically retrieve metadata items (e.g. Account Descriptions) into Microsoft
Excel

O Centrally managed and controlled, no user amendments (client), therefore ‘one
version of the truth’



Hyperion Planning Suite

Hyperion Planning Suite has the following key modules

Oracle Financial Services Balance Sheet Planning
Budget for a full balance sheet and the associated profit and loss statement.

Oracle Hyperion Capital Asset Planning

Automates the planning of capital assets and capital asset-related expenses, such as depreciation, maintenance, and insurance

Oracle Hyperion Workforce Planning
Makes headcount, salary, and compensation planning fast and efficient across the enterprise

Oracle Hyperion Project Financial Planning
Financial planning and forecasting for contract, capital, and indirect projects

Oracle Hyperion Strategic Finance

It helps users quickly model and evaluate financial scenarios, and offers out of the box treasury capabilities for sophisticated debt
and capital structure management.

Oracle Crystal Ball

Spreadsheet-based application for predictive modeling, forecasting, simulation, and optimization



Hyperion Planning
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What is Hyperion
Planning

It is a web based
budgeting and planning
solution that drives
collaborative, event
based, operational
planning processes
through the
organizations for a wide
range of functional and
operational needs

(.

Planning enables you to
Utilize a framework for perpetual
planning, with attention to managing
volatility and frequent planning cycles

Integrate with Oracle® Hyperion Smart
View for Office so that you can enter,
format, analyze, and report on Planning
data in Microsoft Office

Use business rules to perform complex
calculations

Manage the budget approval process
Enhance decision-making with
reporting, analysis, and planning

Enter and analyze data in offline mode



Built-in Options for Hyperion Planning

Adjusting & Spreading Data

O Adjust either individual or multiple data cell values by a percentage or by
amount

O Security lets users only adjust cells with write access
O Further flexibility by utilizing cell locking

Temporarily lock cells while Hyperion Planning calculates and spreads the
results

Time Spreading
U Allows data to be entered at a high level instantly allocated

->Spreading data based on a proportional allocation of existing values
->Spreading week level based on i.e. 4-5-4, 4-4-5, 5—4—4, or None
O Adjusts for Time Balance
O Security lets users only adjust cells with write access
O Further flexibility by utilizing cell locking



Built-in Options for Hyperion Planning

Mass Allocations

O Spreads data even to cells not displayed on the data form

O Allocates data to all source cell's descendants and from subtotal cell or total
cell

O Allocates across multiple dimensions

0 Customized spreading patterns and usage of calculation scripts

d Bottom Up , Top Down, and Middle Out based allocations

Grid Spread

O Specify an amount or percentage to change values on the data form

U Selectable spreading patterns (Proportional, Even Split, & Fill)

U Ignores read-only, locked cells, and cells having supporting detail.

O Data integrity is safeguarded by spreading values only to cells that you have
access to.



Hyperion — A Typical data subbmission process

You can either decentralise planning with central controls, as shown below
OR

Planning can be done centrally with appropriates approvals
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level 1
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level 2

level 3
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level 4
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Promote

&
Group reporting review Adjustments ﬁ
and adjustments (Promote) Promote
J
Basic user Loador | | |
(Local Accountant) Input Data |
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>
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Hyperion Planning

Transaction versus multidimensional processing

4

d

d

Planning uses multidimensional
processing, whereas enterprise
resource planning (ERP) systems use
transactional processing.

This type of processing is good for
quickly storing and retrieving data.
However, because the data is stored in
separate tables without a hierarchy or
relationship, complex queries are
required for analysis of the data.

These data points are organized into
data cubes, and each intersection in the
cube represents a specific data point.

This structure enables you to query and
report on data much more quickly.

W Transactional processing is designed to

store and retrieve transactional
information as quickly as possible. Data
is usually stored in relational tables
consisting of rows and columns, linked
together with primary and secondary
keys.

Multidimensional processing provides
detailed analysis of your data.

Data is organized into dimensions
based on your organization's analysis
requirements, such as:

=  Product Line
=  Markets

* Geographical Region



Hyperion Planning

Dimensions

O Dimensions describe an organization's

Account Entity Period data, and usually contain groups of

Income Before related members. Examples of

T Geographical Quarter1

dimensions are:

I_ =  Account
United States

R —

Gross Margin

Total — January = Entity
Revenues . Period

liforni
California 0

Sales —  February The elements that comprise a

dimension are called members. For

Other
Revenues

= Connecticut example, Gross Margin and Total

Total —1 March Revenues are members of the Account

Costs

|— Salaries

Interest Charges

Massachusetts dimension.

Admin Expense




Hyperion Planning

Dimension Hierarchy

Account [ Parent
o
Income Before
Taxes

L/[ Gross Margin
L

./ \\

[ Child I Total Revenues

Sales

Revenues

-IL Total Coqts

Other

Base-level
members

" Descendants of |

Gross Margin

Members of a dimension are arranged in

hierarchies:

J Upper-level members are called parent
members.

J A member immediately below a parent
member is referred to as its child.

 All members below a parent are referred
to as descendants.

d The bottom-level members of a
hierarchy are called base-level
members.



Hyperion Planning

Dimensions and Data

U Data is typically loaded into base-level

Account _ _ _
members of dimensions, not into parent
Income Before members.
= W Values for parent-level members are
I_ Gross Margin | 500 aggregated, or rolled up, from the
children of the parent-level members.
—[ Total 900 Q In this example,
Revenues
1. Data is loaded to the base-level
Sales 700 members: Sales, Other Revenues,
SEm— -
Other and Salaries.
Revenues | 200 2. The data values are then rolled up
—

into Total Revenues and Total

Costs.

Total Costs 400

Data Load

h 3. Data values from Total Revenues
Salaries | 400 and Total Costs are then rolled up
to their parent, Gross Margin.




Hyperion Planning

Planning Dimensions — Period, Year, and Scenario

A Planning application has six required
dimensions: Period, Year, Scenario, Version,
Entity, and Account.

Multicurrency applications require two other
dimensions: Currency and HSP_Rates.

Q The Period dimension is the time
period, such as quarters or months.

O The Year dimension is the fiscal or
calendar year for the data. An
application can contain data for more
than one year.

Q The Scenario dimension is a set of
related data, such as Budget, Actual, or
Forecast. For example, the Actual
scenario can contain data from a
general ledger, reflecting past and
current business operations.

O The Account dimension specifies the
data to be collected from budget
planners. You can establish accounts for
all budgeted items. Examples of
accounts are Rent Expense and Cash on
Hand.

Q

The Version dimension allows for
flexibility and iterative planning cycles.
For example, your application has two
versions, Working and Final, for each
scenario.

You can also use versions to model
possible outcomes based on different
assumptions about interest rates, growth
rates, and so on. For example, your
application includes a Best Case and
Worst Case version for each scenario.

The Entity dimension represents the flow
of Planning information through your
organization. For example, you establish
a geographic entity for each
responsibility center that submits a
budget plan.

The Currency dimension identifies the
currency in which values are displayed in
applications.

The HSP_Rates dimension contains a

member to store exchange rates for each
currency.



Hyperion Planning

Plan Types

O Plan types represent an Essbase
. database cube, each with their own
dimensionality. You create an Essbase
database for each plan type. You set
plan types for applications, dimensions,
5 and members, and select one database

aBuc:gttli';?\ = Plan Type 1 Plan Type 2 Plan Type 3 for data storage. The stored data values
PP are shared between plan types.

U For example, your Budgeting Planning
application has three customizable plan
types. The default values are Plan Type
1, Plan Type 2, and Plan Type 3.

O If you purchase additional modules, you

modules available Workforce Capital Asset Public Sector use the plan types provided for those

for purchase. Planning Planning Budgeting and modules.
Planning

g

Additional Planning




Hyperion Planning — Navigafing Planning

Planning Components

You create, manage, and administer Planning
applications in a centralized environment.

You use the following components to create and
access Enterprise Performance Management
(EPM) applications:

Workspace 3  Workspace is a Web client that provides
the user interface for viewing and

interacting with content created with
Oracle Hyperion applications.

/ Jd  Oracle® Hyperion Performance
5 > - Management Architect, Fusion Edition,
' - vﬂ /% enables administrators to create, manage,
k~ g’_{/ {g ( A: f;i : //,'; and deploy applications.
AR < Planning applications enable users to

Performance Management enter and analyze data in data forms.
Architect Planning Applications



Hyperion Planning — Entering Data

Data Validation & Messages

./-

| Data Validation

Page | Massachussetts
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|
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For data forms that include data
validation, your administrator can
include data validation messages, which
are displayed in tooltips and specify
colors that contain data validation
errors. For example, a tooltip notifies
you when you enter an expense amount
that falls outside a specific range.

If data forms contain data validation
errors, a Data Validation Messages
pane is displayed. You can expand the
pane to view messages specified by
your administrator, and click links to
correct the errors.



Hyperion Planning — Entering Dato

Spreading the values

I ivpian - ncome statement - Expenses_all *
v/. )
Hyplan
-] 2 Forms | Notice that values are spread from Q1 to its child members, Jan, Feb, and Mar. Cells
§9 verify BR Page | NOOI : Allance Merchan# are colored yellow to indicate that the values have been modified, but not yet saved.
| Income Statement | )
| Standard Data Forms ﬁ / Jan Feb Mar =L Apr May
¢ Target Setting 5230:Airfare Expense 1,666.6666666666¢ 1,666,6666666666E 1,666,6666666666F )spoo S 166.66666666661
B2 Verify Load 5240:Travel Other t 9,922.5 9,922
5350:Software Expense k 2,694.,0625 2,594,061
[=Tot Exp:Total Expenses ""f 12,983.229166666¢ 12,983.2291666¢
q 3Kl | »
4




Hyperion Planning — Calculating Data

Calculation Manager Overview

Rue Desgner O You use Calculation Manager to build,
validate, and deploy sophisticated

- g
ey ¥

calculations. The user interface enables
you to build complex calculations
l easily.

w
«
—
FAE
\
*
<®
i

&
' :.' :! I
LLLLXLY

. . O  You design business rules by addin
Build Validate g y 9
components such as formulas,
conditions, member ranges, scripts, and

loops.

O You can also build business rules with
individual rule components that can be

shared between applications.

Deploy



1. Using Workspace Console for planning , budgeting and forecasting
a. Web Forms b. Review Dimension Hierarchy c. Task List

2. Using Web Form -- Web based Hyperion Planning tool
a. Review existing plan b. Adhoc Analysis of the plan c. Enter budget
d. Copy Working to Final Version of Budget

3. Using Smart View - Excel Based Hyperion Planning tool
a. Review existing plan/budget b. Review multiple plans/ budgets at the same

time

4. Reporting
a. Sample Web Analysis b. Sample Excel based Report

5. Review Capex / Workforce Planning Application
Predefined with all web forms

6. Oracle Crystal Ball
Time series forecasting , Monte Carlo Simulation



Hyperion Planning — Navigation

Workspace Elements

Workspace provides several ways to select tasks
and documents:

-/ P

Navigate Menu bar
menu | P manage documents, task lists, and

Toolbar favorites.

W Toolbar buttons open dialog boxes to

Navigate Fie Eot View Favories Tools Hey

* Bpoe & B O f W The view pane enables you to display

either the documents and tasks or the task

Hyplan - Ad Hoc Standard Expenses = o . . .
i Application lists for an application.
Folders / tabs D ) )
1 Rost 1| o |Name & \ J | Tyoe weal Q  The menu bar contains commands in the
§ Sample Content | P Sample Content Folder 9/1 form of dl’Op-dOWﬂ lists.
£ Shared Workspace Pages ) Shared Workspace Pages Folder 9/1
¢ ) Users £ Users Foiger Jd  The content pane is the main display area
(! 1 .
r— N 7 N in Workspace.
View Content . '
pane pane W The application tabs display the open

applications.

d  The Navigate menu enables you to access
applications.



Hyperion Planning — Navigation

Planning Applications Planning
Q In Planning, all data is processed within The Planning interface provides you with
applications. several tools for working with data forms.

O An application is a related set of dimensions
and dimension members that meet a specific

Q The Planning menus are based on

your user role. For example,

set of analytical or reporting requirements. For administrators can access the

example, you can have one application Administration menu, but planners

named Test for development, and another

cannot.
application named Production to roll out to
y Q The Planning toolbar contains
Menus buttons that you use to work with
i Toolbar
Navigste Fie Edt Ve Favortes Tools Adminswaton H data
# B o % Boore ® s BO =“mip LW
Q The Planning view pane displays data
Hyplan form folders that you use to navigate
" B verty % o=l [ Mocusomer =] [ 250 =l oo = to data forms.
1 icome sistenent s [ow = %
= - ~ N QO The Planning content pane displays
Jan | Feb Mar Q1 I~
5100 219,558.3003| 208,580.3854: 210,775.9688|  #missing | 217 Al the selected data form.
S120 :1,955.32994‘33,359 03874 | 21,077.59698 #missing |21,
S130 10,977.91497 | 10,429.01937 | 10,538.79649 #missng |10,{
sz210 10,977.91497 | 10, 479 01937 10,538.79849 #missing | 10,(
S220 16,466 15,808.19724 #rvssing 16,2
S230 usi Content 21,077.59698 #missing 21,7
o pane | p—
&) <Calciate Data Form - Standar 310 M, dren | 4 nan anara 4 aen ameee pa—— Y
(&) <Calcdate Currencies - Standai —‘l ; 2
Save




Hyperion Planning — Navigation

Opening a data form

Navigate Fie Edit View Favoriites Tools Administration Help

A K & % Explore

22N Hyplan - Select Data Form *

Hyplan
-| §.) Forms Data Form Description
i verify BR Commission and Salary Expenses Data Entry for Commission and Salary Expenses
[ In Statement Composite Customer Sales Customer Sales
= con& Convert Currencies Handling currencies in a data form
! ) Standdid Data Forms Customer Sales Detailed Customer Sales information by account
I Target Setting Customer Sales Summary Customer Sales Information
1 verify Load 1 Commission and Salar, Data Entry for Commission and Salary Expenses

Sales All

Data Entry for Standard Expenses
Standard EXpenses with Validation Rule  Data Entry for Standard Expenses

-3 Hyplan - Ad Hoc Standa;d Expenses * Search l

rement Page | Massachussetts =l [ eudget =] [ Fr11 =] | orait1 =] Go

'
'
B Standard Data Forms
!
'

Target Setting Jan Feb Mar =Q1 Apr May X

PARNEEERCUIEE 203,580, 36540 210,775.9683 #Fmissing | 217,099.24732 210,586.2699¢ 212,69

) verify Load 5100:Salary Expense

5120:Commission Expense 21,955.82994 | 20,858.03874 | 21,077.59698 #missing | 21,709.92483 | 21,058.6266 21,269
5130:Advertising Expense 10,977.91497 | 10,429.01937 | 10,538.79849 #missing 10,854.96192 | 10,529.3133 10,634
5210:Fringe Expense 10,977.91497 | 10,429.01937 | 10,538.79849 #missing | 10,854.96192 | 10,529.3133 10,634
5220:Payroll Taxes 16,466.87295 | 15,643.52856 | 15,808.19724 #missing | 16,282.44387 | 15,793.96995 | 15,95

“ 5230:Airfare Expense 21,955.82994  20,858.03874 | 21,077.59698 #missing | 21,709.92483 | 21,058.6266 | 21,269




Hyperion Planning — Creafing Applications

Performance Management Architect Overview

. » - 4 Performance Management Architect is a

y .. -7 component of Oracle’s EPM System that
' i g},’_/{- enables administrators to create, manage,

& o . > and deploy Oracle Hyperion applications

Performance Management within a single interface.

Architect d  Performance Management Architect is
| integrated with:

. Oracle® Hyperion Financial Management

i l . Planning

. Essbase

. Oracle® Hyperion Profitability and Cost
Management

W You can design applications graphically for all

!’ ' of these products in a single environment.
Financial Planning Essbase Profitability
Management and Cost

Management



Hyperion Planning — Creafing Applications

Performance Management Architect Modules

Performance Management Architect has the
following modules:

\‘? e d Data Synchronization enables you to
" B create data synchronizations between
S Oracle Hyperion applications. For
S5 N\E example, an administrator synchronizes
Dimension Library Application Library Calculation Manager data betwsen two Planning applications, or

between one Financial Management
application and one Planning application.

% Q Application Upgrade is a utility that
// l T enables upgrades from previous releases
:/// Pl y %, P9 P .
/4 P 2 Library Job Console is a console that
provides a summary of Dimension Library

|

Data Synchronization  Application Upgrade Job Console and Application Library activities.



Hyperion Planning — Creafing Applications

Applications and Performance Management Architect

PRV orcniorer

Application Library

O You use Performance Management Architect

to create applications and manage the
dimensions required by applications.

W After you create an application, it is displayed

J‘ & & in Application Library. You validate and deploy

applications from Application Library.

Comma Finbud Hyplan
d  You can also view the status of the
application in Application Library.
O You manage the dimensions for applications
Summary Dimensions in Dimension Library.
Name : Hyplan Account
Type : Planning Alias
Created : Saturday, September 11, 2010 10:55:06 PM Salesrep
Last Deployed : Thursday, September 16, 2010 11:32:48 Currency
AM Entity

Status : In sync with deployment Customer




Hyperion Planning — Creafing Applications

Local and Shared Dimensions

In Performance Management Architect, dimensions

Local Dimensions Shared Dimensions . L .
(( > within an application are either local or shared:
»
> » (f % A Local dimensions are maintained within
J - ‘ 2 < > a single application. Adding or removing
: » t ) 4 dimension members or changing member
L ‘ t‘ Ll t‘ properties has no effect on dimensions in
) other applications or in Shared Library.

W Shared dimensions are available to all
applications and can be individually linked

to one or more applications when included

[ ]

Multiple Applications

in each application as a shared dimension.
Changes made to the dimension in Shared
Library are automatically inherited to every

|
-
#

F application sharing that dimension.
s

|
¥

Single Application

d  You can change local dimensions to
shared dimensions in Dimension Library.




Hyperion Planning — Creafing Applications

Creating Planning Applications

Drmencion i : D Advanced . T .
LM Application Creation Wizard * "\ilkaaciel \llssid  You create Planning applications by using
ton Ty D Select: lication Set . . . o
e, DR 2 N .| Application Creation Wizard to perform the
Appication Information — .
ame — following tasks:

1. Create the application shell.

b 2. Add either local or shared dimensions to

Descrotion Planning and budgetng appication

\

Create Slank Appication: r the appllcatlon.
Ngowewo L 3. Modify the application settings, such as
creating dimension associations or editing

Gonera

m AT = = | the application properties.

Next Cancal 4. Validate and deploy the application.

Application Dimensions Application
Shell Properties



Hyperion Planning — Creating Applications

Validate and Deploy Applications

After creating an application, you validate and

then deploy it:
. When you validate an application, the
Validate system ensures the presence of all

dimensions and other information required
to deploy the application.

. When you deploy an application, the
system creates the application on the
Planning application server. The
application is then accessible to end users.

W You can also redeploy a previously deployed

Deploy - application. A redeployment merges or
y
)I
’

replaces the application metadata based on

the changes since the last deployment.

Application Application End Users
Server



Hyperion Planning — Creafing Applications

Common Menu Navigations

Navigate Fie View Favorites Tools Help

Navigate Fie E Vi Favorites Tools Administration Help

CirieN 9] applications >

Document... -
/19 Explore

> Workspace Page...
» Personal Page.. Ctrl=Shift=P Workspace Pages  »
Edit Application Folder Ctrl+Shift+F Shared Services Console
Import N Dimension Ctrl+Shift+N Workspace Server Settings
Preferences... Appligation (Z Ctri=Shift+Z Manage Preferences
Log Off — Reporting and Analysis >
Exit %ﬁCfaI}CES

Dimension Library

Application Library
Navigate Fie View Favortes TYools
Data Synchronization
A B o * Epore -
Calculation Manager
HomePage | Dimension Library Transform Classic to EPM Architect

Application Type > Dimension Selection > Application Settings
Application Information
Name: Planbud
Type: Planning - Consolidation System Messages

~

-

onsolidation Users on System

Description:

Manage Consolidation Servers and Application

Create Blank Apphcation: r
Auto Create Local Dimengions: r
Planning
Apphication Type: Genera w Defaut Currency: usd v
Plan Type: W Use Mutile Currencies
M Plan1Name: Incstmt
¥ Plan2 Name: Balsheet
[~ Plan3Name: ] lplan3
[} T workforce Name: Wriforce B

[T Capital Asset Name: Capex




Hyperion Planning — Creating Applications

Validate your application

Navigate Fie View Favorites Tools Help

A B rn 2 Bxplore| S

HomePage ik sl Application Creation Wizard *

Application Type > Dimension Selection > Application Settings
Planbud v Properties of Planbud
Member Category: Planning ~ M2
~| 0 Planbud
+| Mz HP_Account (Shared) Property Value
- ﬁi:i HP Alias (Shared) Valid For Capital Asset Plan I )
| _ S ) e
+] '¥£$1 HP_Currency (Shared) Capital Asset Plan Name Capex )
+] 4%, HP_Entity (Shared) Defaci Qurency usD - 2
+| \fy HP_Period (Shared) Multiple Currencies )
+| th' HP_Scenario (Shared) Date Format MM-DD-YYYY v
+| " HP_Version (Shared) Base Time Period 12 Months b3
A HP_Year (Shared) Weeks Distribution Even z
Fiscal Start Year 2009 H
Fiscal Year First Month Jan 73
Fiscal Year Start Date SameCalendarYear 73
Default Alias Table default v
™ Deploy when finished ‘ valRate | Clear | Errors: Warnings:
Wy
= Message
Press the Validate button to validate your application.
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Deploy your application

Deploy (]
Application Name Planbud
Description
Notes
Instance Name PLANNING 54|
Web Server UPK1112
Application Server PLANNING =
Shared Services Project Default Application Group =
Data Source STO1PLN10 (b J
Create Qutline ¢
Refresh OQutline r
L
Create Security Filters [ F
3
Shared Members Security Filters ~
Validate Security Filter Limit r ~ 5
./
| Click Deploy.
Full Deploy ~ \]/ “
Help I Deploy ‘ Cancel
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Filtering and Sorting Data

) 4 O You can sort data form rows and

Page | Massachussetts ~| | Budget =| | Fy1t =] | Draft1 =] Go columns to view data in ascending or

descending order. You can also sort
Jan Feb , Mar - within the dimension hierarchy or across

5100:Salary Expense 219.558.3003¢ 20)8,580.3854 210,775.9688: # data for a data form

- Headcount and rates . '
5120: Commission|™ g e to-Fit ,858.03874 | 21,077.59698 # Q You can filter rows and columns to
5130:Advertising|__Filter 4 : 79849 # select which rows or columns to display

Sort »| Sort Ascending | 7 ) _
5210:Fringe Expe—prri— ~| Sort Descending [79849 " in a data form. You can filter to keep or
- = Honor Hierarch i i

5220:Payrol Taxd _Show member in outine e 1:3,er5.19724 p exclude members by using simple

S ~ functions that compare your criteria
against specific values.

s L1400 AL, D0U, ST9% £1U, 7 79,9000, ¥
' . Headcount and rates !
> Size-to-Fit ,858.03874 | 21,077.59698 #
} Filter p_Fier...
Sort » | Hide rows with no data
‘ G > Hide rows with zeros
\ <h ber i outl Hide rows with zeros and no data_|

~ . oW member In outline | a5 52096 | 15,005.19724 1 71

R Filker Row -
|Exclude ~ || Greater Than or Equal To _ ||S,000 Filter Row
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Validation in Web Forms

Hyplan - Income Statement - Expenses_All *

Hyplan
- p — -
5 o.rms \D The data has been saved. | %/ -
g verify BR (w]
> [*T}
[ Income Statement -+
:_ ) Standard Data Forms Page I NOO01 : Alliance Merchandise 2 l 220 : Georgia ZI I Draft 1 Z| I Budget z, l Fy11 z, Go %
' Target Setting = =
- Verify Load Jan Feb Mar =Qt Apr v o
g ety 5100:5alary Expense A é"
5120:Commission Expense =
1]
5130:Advertising Expense & §
Q
5210:Fringe Expense 8
” 5220:Payroll Taxes
5230:Airfare Expense 1,666.6666666666¢ 1,666.6666666666¢ 1,666,6666666666¢ 166.6666666666661 166,66
5240:Travel Other Expense exceeds max of 3k.
<Calculate Currencies - Expenses_A 5310:0ffice Expense Row 5230:Airfare Expense. Column Q1
<Calculate Data Form - Expenses_A '
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Cell Comments in Web Forms

Page I Massachussetts

=1 | Budget = | Fv11 =) | Oraft1 | Go

Jan Feb

Mar

5100:5alary Expense
5120:Commission Expense
5130:Advertising Expense

5210:Fringe Expense

219,558.3003¢ 208,580.3854¢

21,955.82994 2n asa n3R74

10,977.914{ Indicates a

10,977.9149 A

5220:Payroll Taxes

S23N:Airfare Fxnense

A\

N

16,466.87435.15,643,52656

24 _OEC _o2004 | 20 OCO N2074

210,775,9688!

21077 '-'.QAQS;
cell comment

3

15,808.19724

24 0737 0N

#rv

#n

#rv

/2 Comment - Windows Internet Explorer [ =] [
J

| . |

1 - 1

| Jan
This figure comes from our analysis of taxes
paid in 2009 and 2010.

5220 : Payroll Taxes
|
Help Submit Cancel

You add documentation to your plan in
the form of annotations. You can add
annotations at different levels,
depending on how general or specific
the explanation needs to be.

You can enter very specific annotations,
called cell comments, at the cell level.

If a cell contains comments, a blue
triangle is displayed in the cell.

If you have read access to a cell, you
can add annotations at any level,
including summary time periods, across
multiple dimensions, non-level 0
members, calculated cells, and read-
only cells.
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Pivot in Web Forms

Navigate File Edt View Favorites Tools Administration Help

A B & % Bgoe Bl @ & = = MR BN

Hyplan - Ad Hoc Standard Expenses *
— Select Ad Hoc, then Pivot To, and then Row.
page [ Local =] [ o Customer -] [WNMCEMNNGN  7arc  ~ o] FvoiTo s
Y | Show member in outline Move »  Column
Jary February March = T Zoom In My June EQtr 2
’ ’ i ’ Zoom Out ’ i i
[=5elling, Geneneral and Admin Expenses | 8,9339¢ 319,597.9865(| 322,962.1738: #missing | 3| Remove Only 150887 325,898.2267: #missing | 30¢
o o . - Keep Only o . o
Headcount
missing #missing #missing #missing Select Members missing #missing #missing
T&E Rate missing #missing #missing #missing Change Alias M nissing #missing #missing
Software Rate missing #missing #missing #missing #missing #missing #missing #missing
Square Footage Rate ‘missing #missing #missing #missing #missing #missing #missing #missing
- |Interest Rate ‘missing #missing #missing #missing #missing #missing #missing #missing
>
1 |Fringe Rate missing #missing #missing #missing #missing #missing #missing #missing
P T S,
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Business Rules

Business
Rules

e

Essbase Calculation
Scripts

(

Planning

v N\

In traditional multidimensional
applications, your organization typically
requires more complicated calculations
to be performed than can be defined
within your dimension hierarchies or
with member formulas.

For these more complex calculations,
you can create business rules, which
leverage the power of Essbase
calculation scripts, and integrate with
Planning. For example, you can
calculate aggregated totals and allocate
totals based on headcount.
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Business Rule Templates

J Templates provide you with a starting
point for common or frequently used
calculations. You can start building your
business rules with the provided

templates.
\ ‘ Q You can work with predefined templates
Predefined Templates h'*"u.,(._ or you can create customized
Q §)(,,L templates. For example, you can use
\""m templates for clearing, copying,

allocating and aggregating data.

Business Rules

Customized Templates
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Organize your Business Rules in Calculation Manager

Product

] Hyplan Rules

] Calculate Expenses

] Calculate Fringe
Expense

Planning
Application Hyplan

L( Plan Type | Incstmt
—{  Rule Sets
— Rules
-[ Fomulas
-{ Scripts
-{ Templates ]

J

4

You use Calculation Manager to
organize and maintain business rules.

You can organize rules into rulesets so
that you can launch several rules in a
specified sequence. These objects are
categorized by product, application, and
plan type.

You can also create folders to organize
business rules. You can also search for
and filter objects.
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Navigate to Calculation Manager

Navigate Fie View Favorites Tools Help

Applications
715 Explore
Workspace Pages >

;3/ Adminigter > ;j Shared Services Console -
Name Description
% Sched » [T3 workspace Server Settings —
+| g Consolidation
nen bema Manage Preferences ~
Open tems P - # Planning
| ®e([@ Reporting and Analysis > 2 @ryoan  ight-click the Rules node, and
/& Annotations = ,t ) Hyplan| -
& Hyplan | : + %2, Rl select New.
_—; Open... " Dimension Library EE:‘: Incs"ﬁ‘[
Sh Application Library I}S —y
@~ Data Synchronization : '
as " +| L—j Formulas
LEE] Calculation Manager > \jS ot
+| || Scripts
&b Transform Classic to EPM Architect R pl :
: +| a5} Templates
a Library Job Console = P
+| L Balsheet
) Classic Application Administraticn > -
B o +| P Essbase
,x. Consolidation System Messages ‘
&% Consolidation Users on System New Rule (2]
#% Manage Consclidation Servers and Application Name:

Planning Copy and Adjust Data| k

Application Type: Planning =
Application: Hyplan hd|
Plan Type : Incstmt =

Help OK Cancel
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Define Business Rule using GUI

Planning Copy and Adyust Dats * QRN

Rule Palette
New Objects Rule Designer
ﬁj Formula
Lﬁ Script

2> Condition Q) '[_E?j \-)

(&) Member Block

Begin Copy Data End 0
&1 Member Range ! Py Deploy Eoiil
-
& Fixed Loop 1 Validate and Deploy (Q) Cirl+=Q
er
Copy Data Wizard
Point of View > Copy From
Copy Data Wizard
Copy From
Point of View » Copy From » CopyTo
Select members from which to copy Predefined Sel i
data Use Predefined Selectior Copy To
Member Selector Select members to which to copy the Use Predefined Selection
data
Dimension Select Value Member Selector
Currency
Customer Dimension Select Value
Period Scenario "Budget”
Scenario "Actual” verson I Working

v B ﬁ Year FY 108
Version Final

Year [Fraol N
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Launch Business Rules

Navigate

Fie §

P IR Tools menu Change Password.
Install >
e Hyplan - Income Staten Planning
Hy Manage Approvals
- §2 Forms Copy Version
. vision:
| VerifyBR — Business Rules
i Income Statement Job Console |]
§  Standard Data Forms ~ L
, Copy Link =
§9 Target Setting Pag y Link Draft 1 | | Budg
Custom Links
'

) Verify Load

Tools Administration Help

s Export as Spreadshest

Ad Hoc >

Jan

FOUC-TOUTEtwor

65,550.24

4000-200:Chips Sal

12,393.2025

4
-

4000-300: Compute

4

Launch rules from the view pane. I“OD’AW"“’“" 37,568.,790000000C

-500:Data Wa

109,889.4625

39,634.875

sl

Z

& <Calculate Currendies - Sa es_All> 4000-600:eBusines 48,269.655
[ <Calculate Data Form - Sales_All> 4000-700:0LAP 5‘1 17,364,375

O After you deploy business rules and
rulesets to Planning, you can launch
them from data forms or independently
from the Tools menu.
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Approval Process Overview

—

O Planning uses the approval process to
track budgets by planning units.

& A planning unit represents a slice of
data at the intersection of a scenario, a
version, and an entity or part of an
entity.

3 A planning unit is the basic unit for
Approval Process preparing, annotating, reviewing, and
approving plan data. For example, you

have a planning unit that includes the
Headquarters entity, Forecast scenario,
and Working version.

Headquarters
Entity

Working
Version
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Planning Unit Hierarchies

A planning unit hierarchy consists of
planning units and entities that are part

North America of the review process. For example, you

North | | Signed Off have a planning unit hierarchy for the
America ' Draft 1 version, Budget scenario, and

North America entities.
East

ISigned Off O Parent/child relationships between
planning unit hierarchy members affect
' ) West the review process. For example, if you
Bud Signed Off change the status of all children of a
get planning unit to one status, such as
Draft 1 Nevada ,
Signed Off Signed Off, then the parent status

changes to the same status as its
children.
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Planning Unit Validation

\
(W

A planning unit moves from one

TR

|~
It~ . .
zl-- reviewer to the next until the approval
- - .
z- e process for the budget is completed.
-
= / - - -
- Each reviewer must validate the
-
-~

planning unit before sending the budget
to the next reviewer.

The validation runs all data validation
rules defined for the planning unit with
which the reviewer is working, and
reports any data errors or changes in
the planning unit promotional path. For
example, if a planner enters an expense
amount that is above the maximum
allowed, you can prevent the planning
unit from being promoted until the
amount is adjusted to fall within
company guidelines.



Hyperion Planning — Manage Approval Process

Planning Unit Promotional Path

4 A planning unit moves from person to
person and department to department
FY11 based on the owners and reviewers
+10% assigned to each planning unit and its
parents in the planning unit hierarchy.
‘ This is defined as the potential

MSmith promotional path.
HR Manager

L” .
budget year, approval from someone

RJackson JGual JWhite other than the next reviewer is required.
lllinois Central Budget North L .
Planner Manager America Data validation rules can automate this

O Sometimes, however, budget
calculation results change the person
who reviews the budget next. For
example, if salaries for a sales group
are more than 10% over the previous

Administrator redirection action when exceptions
occur.
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Out of Office Assistant

O  While you are away from the office, you

/~ Out of Office Assistant - Windows Internet Explorer =10 x|
can use Out of Office Assistant to
Out of Office Assistant designate alternative reviewers to
[V 1am currently out of the office. assume responsibilities for your
Select Action  Select Next Owner planning units.
|Delegate | |Rjackson  +| .
v O Out of Office Assistant enables the
Enter Annotation .
Randy, I will be out on vacation for a week. Delegating to you. _:] approval process to continue even

when planning unit owners are
| unavailable.

Help Save Cancel
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Demo Steps — Manage budgets by planning units

Hyplan - Select Data Form *

Hyplan
-| ¢ Forms Data Form Description
;) Verify BR This Folder is empty.
| Income Statement 4
| Standard Data Forms ' i ) o o ,
§9 Target Setting Let's begin this demonstration in the Hyplan application where you work with
§9 verify Load the approval process to manage the budget by planning units.
I Hyplan - Check Status and Manage Approvals * _

Hyplan
-/ |_ Forms
} Verify BR ' i . '
, Select a valid scenario and version, and then click Go.
g Income Statement . .
3 Standard Data Forms Scenario Yersion
} : andard Data Forms IBUdget _'J I;I
§ Target Setting
1 Verify Load

Display @ Treeview © Flat View

(z v
Display  TreeView  Flat View

Search: |Name | | 9@4} ‘é@
Planning Unit Plan Cycle Approvals Status Sub-Status  Current Owner Location Path  Action
[=IHyplan Planning Unit Hierarchy Start  Exclude
[=] North America v "  Under Review Kreilly B! Details
Central o " Under Review Kreilly B! Details
[ South a "  Under Review Kreilly B! Details
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Demo Steps — View potential promotional path

[ Hyplan - Check Statu /> Promotion Path - Windows Internet Explorer

y
-~
) Potential Promotional Path |
-| {_ Forms
) verify BR - :

| Income Statem
| Standard Data
!
!

The Promotion Path dialog box for the planning unit

) Target Setting is displayed with Kreilly as the current owner.
v fy —~ 2 \
erify Load o) % % % ® \I/ 4
Kreilly Rjackson trnadmin
Start 250 East Morth America End

Current Location
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Demo Steps — Change status and submit for promotion

Check Status and Manage Approvals Hyplan 0
=l B Fm @ validation submitted %] 12
§ Verify BR
§ ' Income Statement
| | Standard Data Forms Select a valid scenario and version, and then click Go.
I ) Target Setting Scenario Version
§ ) verify Load |Budget | |Draft1 | | Go Out of Office Assistant
I N
Display € Tree View & Flat View ™ Select Mine Change Status
Planning Unit 57 A Approvals Status s Sub-St Click Change Status. 7 Path Action 4|
[T 250 Under Review i B! Details
[~ 250:5100 Under Review Kreilly 250 B! Details
) [T 25005120 Under Review Kreilly 250 B! Details
[~ 250:5130 Under Review Kreilly 250 BP Details
5] No Forms available [T 250:5210 Under Review Kreilly 250 B! Details
[T 250:5220 Under Review Kreilly 250 B Details __
. . Mo Additional . .
250: 5230 Under Review Approval Required Kreilly 250 B! Details
250: 5240 Under Review Kreilly 250 B Details

./-

rEyeemes A ccept the default action, Promotg, and the next owner according to
the promotional path.

b
Select Action Y Select Mext Owner
IPromote ;l I <Automatic > ;I

Enter Annotation Validate C

o]
=

¥ Location <7
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Task Lists

/2 q l
T
» Data
URLs forms
o
——
Business

rules process tasks

To do
items

Task lists enable you to navigate
through a unique planning process. You
can use a step-by-step wizard to quickly
and effectively work on task lists.

Task lists may consist of URLs,
business rules, data forms, approval
process tasks, or descriptive to-do
items.

Task lists are created by administrators
or interactive users, and can be
imported into Microsoft Outlook.

Task lists are also created automatically
when validation errors occur in the
approval process. These task lists
assist you with identifying the exact
location of the errors and guide you in
correcting them.
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Launch a Business Rule as per the Task List

EIORACLE’ Enterprise Performance Management System Workspace, Fusion Edition

Navigate Fie Edit
A K = Bl

Hyplan - Task 2 of

-| @ North America IT
E?'_, Enter IT Expl

[#) Calculate IT v

v

View

Favorites Tools Administration  Help
Advanced Mode

Task List

@ Hyplan IT Expense Allocation was successful, | %]

Ediit Account Annctations Repo
Instructions % \_ﬁ Status
Currency
Refresh
View Masthead Ctrl=Alt=0
View Pane Ctrl+Alt+1

Plan Type:

¥ Incstmt
Business Rules
Incstmt - Rule - Hyplan IT Expense Allocation
4

Launch

Hyplan
@ Hyplan IT £
Select Rule
Plan Type:
¥ Incstmt

Business Rules

Incstmt - Rule - Hyplan IT Expense Allocation

Laurizh

‘ Select the Complete check-box to
complete the task.

:Il‘/
‘ I Complete




Hyperion — A Typical data subbmission process

Proposed data submission process for Financial Services Company is :

Step 1:

The system administrator starts the reporting process by promoting all the entities for that period from NOT
STARTED, through FIRST PASS to Review Level 1.

Step 2:
Left to Right. The basic user loads data for its entity or cost centres.

Step 3:

The user review data for its entity or cost centres. The basic user has write access to the data. Once passed the
relevant validations for the level, the basic user will submit (“promote”) the data to next level. Once the user has
done this, he has locked the data — he can still view it but can no longer change it.

Step 4:

The data is now available to Group Finance at Review level 3 they can run sub-consolidation and review the data
received from the businesses prior submitting (“Promote”). Users will have the ability to retrieve Review levels
and status in SmartView and Bl+ Webforms.

Process Management will have the following implications:

—->When data is promoted, the data for the reporting entity and time period will be locked.

—>The reporting entity can only have that reporting period unlocked by their respective parent entities performing a
HFM ‘Rejection’. This process of submitting and rejecting data will be automatically tracked within HFM and notes
and commentaries can be associated with each process.

—>If the Parent Entity has Promoted data, they are no longer able to reject data and Group Finance will be
responsible for such an activity.
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Readers Expectation out of this presentation

Your expectations out of this 5-day Hyperion Planning course, are —
- Overall functionality of Hyperion Planning

- Advanced understanding of Hyperion Planning so that it can help during
implementation.

- Learn System admin activities for Hyperion Planning

o O
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